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Advances in biodiversity genomic sequencing will increasingly depend on the availability of

DNA samples�and their quantifiable metadata�preserved in large institutional

biorepositories that are discoverable to the scientific community. Improvements in

sequencing technology constantly provide longer reads, such that longer fragment length,

higher molecular weight, and overall �genome-quality� DNA (gDNA) will be desirable.

Ideally, biorepositories should publish numerical scale measurements of DNA quality useful

to the user community. However, the most widely used technique to evaluate DNA quality,

the classic agarose gel, has yet to be quantified. Here we propose a simple and

economical method using open source image analysis software to make gDNA gel images

quantifiable, and propose percentage of gDNA �greater than X kb� as a standard of

comparison, where X is a band from any widely used DNA ladder with desirably large band

sizes. We employ two metadata standards (�DNA Threshold� and �Percent above

Threshold�) introduced as part of the Global Genome Biodiversity Network (GGBN) Darwin

Core extension. We illustrate the method using the traditionally used HindIII ladder and the

9,416 base-pair (bp) band as a standard. We also present data, for two taxa, a vertebrate

(fish) and an invertebrate (crab), on how gDNA quality varies with seven tissue

preservation methods, time since death, preservation method (i.e. buffers vs. cold

temperatures), and storage temperature of various buffers over time. Our results suggest

that putting tissue into a buffer prior to freezing may be better than directly into ultra-cold

conditions.
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Abstract 15	

Advances in biodiversity genomic sequencing will increasingly depend on the availability 16	

of DNA samples—and their quantifiable metadata—preserved in large institutional 17	

biorepositories that are discoverable to the scientific community. Improvements in 18	

sequencing technology constantly provide longer reads, such that longer fragment length, 19	

higher molecular weight, and overall “genome-quality” DNA (gDNA) will be desirable. 20	

Ideally, biorepositories should publish numerical scale measurements of DNA quality 21	

useful to the user community. However, the most widely used technique to evaluate DNA 22	

quality, the classic agarose gel, has yet to be quantified. Here we propose a simple and 23	

economical method using open source image analysis software to make gDNA gel 24	

images quantifiable, and propose percentage of gDNA “greater than X kb” as a standard 25	

of comparison, where X is a band from any widely used DNA ladder with desirably large 26	

band sizes.  We employ two metadata standards (“DNA Threshold” and “Percent above 27	

Threshold”) introduced as part of the Global Genome Biodiversity Network (GGBN) 28	

Darwin Core extension. We illustrate the method using the traditionally used HindIII 29	

ladder and the 9,416 base-pair (bp) band as a standard. We also present data, for two taxa, 30	

a vertebrate (fish) and an invertebrate (crab), on how gDNA quality varies with seven 31	

tissue preservation methods, time since death, preservation method (i.e. buffers vs. cold 32	

temperatures), and storage temperature of various buffers over time.  Our results suggest 33	

that putting tissue into a buffer prior to freezing may be better than directly into ultra-cold 34	

conditions. 35	

Subjects  Biodiversity, Bioinformatics, Genomics, Molecular Biology, Zoology 36	

Keywords Agarose gels, DNA extractions, Genomic DNA, Tissue preservation 37	
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Introduction 38	

  39	

 Increasing the length of sequence reads is a core technological challenge in 40	

genomic science. Currently, the most widely used bench top technologies can achieve 41	

quality reads up to 150–500 bp in length (Glenn, 2011; Loman et al., 2012), but longer-42	

read sequencing technologies are increasingly feasible (Loman and Quinlan, 2014). 43	

Therefore, access to high quality, high molecular weight DNA will become increasingly 44	

crucial. It is now feasible, practical, and increasingly more common to sequence 45	

complete genomes of non-model organisms (e.g. Pisani et al., 2015).  As biodiversity 46	

genomics expands to rarer, harder-to-access, or vanishing organisms, obtaining “genomic 47	

quality” tissues—that provide high molecular weight DNA—becomes a significant 48	

challenge.  49	

 Natural history museums and academic institutions are currently obtaining, 50	

curating, and rapidly increasing biodiversity biobank collections (i.e. biorepositories), in 51	

order to maintain genomic quality material of non-model organisms, and to make this 52	

material available for scientific researchers conducting genomic analyses around the 53	

globe (Droege et al., 2014).  In turn, making massive tissue and DNA collections 54	

discoverable is a priority for data aggregators, such as the Global Genome Biodiversity 55	

Network (GGBN; http://www.ggbn.org).  GGBN is a network of institutions dedicated to 56	

preserving genetic resources, but also to advancing the data model for tissues, DNAs, 57	

RNAs, and similar resources and their standardizations (Droege et al., in press).  58	

 We present a simple, cost-effective agarose gel electrophoresis method for 59	

qualitatively analyzing genomic DNA (gDNA) extractions (for genomic analyses) that 60	
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can provide a quantifiable value of gDNA.  Our method requires only basic molecular 61	

laboratory equipment (standard TBE gel rigs, UV imaging station, etc.); thus it does not 62	

rely on any expensive reagents or more expensive analytical quantification equipment 63	

(e.g. Spectrophotometers, Automated Electrophoresis Systems, Tape Stations, etc.).  64	

 Studies that explore the impact of tissue preservation on DNA quality often 65	

measure DNA concentration or test whether particular loci will PCR-amplify and 66	

sequence using traditional Sanger methods (e.g. Dawson et al., 1998; Vink et al., 2005; 67	

Yodder et al. 2006; Erkens et al., 2008; Frampton et al., 2008; Gaither et al., 2011; 68	

Moreau et al., 2013).  However, these approaches are limited, as even fragmented DNA 69	

may amplify and produce high quality Sanger sequencing products, particularly when 70	

these products are in the size-range for Sanger methods [e.g. ~500–1000 base-pairs (bp)].  71	

DNA concentration can be increased by adding more material (i.e. tissue) or combining 72	

multiple extractions from the same material, and does not provide any information about 73	

size. For genomic quality DNA, it is preferred to be mostly intact (whole chromosomes 74	

and organelle genomes), particularly if the intention is to sequence entire genomes, as the 75	

assembly of degraded gDNA (non-randomly) sheared gDNA prior to library preparation 76	

can be problematic for most NextGen platforms (Chen et al., 2015).  Therefore, in order 77	

to assess the quality of their DNA, many researchers use agarose gels with high 78	

molecular-weight DNA ladders to visualize size and quality (Williams, 2007; Gaither et 79	

al., 2011), in addition to more sophisticated methods such as spectrophotometry, 80	

flourometry, or automated electrophoresis methods.   81	

 Here, we propose a standardized, simple method for electrophoresing genomic 82	

DNA on agarose gels with the standard » phage HindIII ladder.  The size of the gDNA 83	
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can be assessed by comparison to any of six bands in the HindIII ladder (2,027 bp, 2,322 84	

bp, 4,361 bp, 6,557 bp, 9,416 bp, and 23,130 bp), and from this comparison, the percent 85	

of gDNA greater than a given band size can be calculated from a regular gel image.  We 86	

recommend this method to standardize quality assessment of tissues collected and 87	

reporting by biorepositories and data aggregators such as GGBN.  We suggest use of the 88	

~"9 kb" (= 9,416 bp) size marker as a working standard, because it is substantially longer 89	

than standard NextGen reads (e.g., Illumina, etc.), and given current technologies, would 90	

be an appropriate minimum for long read sequencing.  However, any size marker can be 91	

used to quantify gDNA, hence the method is referred to as "greater than X kb."   92	

 We present our method with a case study exploring preservative methods within 93	

field collection workflows that yield DNA of sufficient quality and quantity suitable for 94	

genomic sequencing.  Within this case study, fresh, field collected tissue of a fish 95	

(Morone americanus) and a crab (Callinectes sapidus) were used to test if DNA quality is 96	

dependent on treatment and time until preservation.  Alternative preservative solutions, 97	

temperature, and time were used as variables.  Immediate cryopreservation was used as a 98	

benchmark for comparison as most researchers to date believe that freezing tissue at 99	

ultra-cold temperatures, such as -80°C or -190°C (liquid nitrogen), is the best 100	

preservative method for yielding genomic quality DNA. 101	

 We address four questions in this study: 1. Can DNA quality (in terms of 102	

fragment length) be measured quickly, consistently, and economically?  2. How does 103	

preservation method (buffers vs. temperature) affect DNA quality? 3. How does time 104	

since death affect DNA quality?  4. How does storage temperature (in various buffers) 105	

affect DNA quality?  106	
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 107	

Materials & Methods 108	

 109	

Evaluating Preservation Methods 1.0 110	

 111	

Tissue Collection 1.1 112	

 Muscle tissue was collected from two species: Morone americanus (white perch, 113	

hereafter "fish") and Callinectes sapidus (blue crab, hereafter "crab") at the Smithsonian 114	

Environmental Research Center (SERC) in Edgewater, MD.  The crabs were euthanized 115	

using liquid nitrogen asphyxiation (held above liquid nitrogen, which depletes oxygen), 116	

and the fish were euthanized with MS222, following our ACUC protocols.  Individual 117	

fish were filleted immediately after death. Fillets were cut into small strips (~0.5 cm x 5 118	

cm) and immediately submerged in liquid nitrogen (LN2). Individual crabs were 119	

dismembered upon death and claws were immediately submerged in LN2. Two 120	

experiments were conducted ("Time" and "Temperature"; see below), and because this 121	

involved processing nearly 500 samples, all samples were submerged into LN2 within five 122	

minutes after death to reduce postmortem tissue degradation. Each experiment only used 123	

the tissue collected from a single individual. For both experiments, each treatment 124	

combination consisted of ten replicates. 125	

 126	

Time Experiment 1.2 127	

 Fillet strips and claws were thawed and sub-sampled; samples were weighed to 128	

the nearest mg before being subjected to one of seven preservation treatments: 1 ml 95% 129	

PeerJ Preprints | https://doi.org/10.7287/peerj.preprints.2202v1 | CC BY 4.0 Open Access | rec: 1 Jul 2016, publ: 1 Jul 2016



	

	 7	

EtOH, 1 ml salt-saturated DMSO-EDTA buffer (modified from Seutin et al., 1991), 1 ml 130	

DNAzol (Molecular Research Center), 1 ml of RNAlater (Ambion), 300 µl M2 tissue 131	

digestion buffer (Autogen, Inc.), frozen at -20° C, frozen in LN2 (j-190°C).   The 132	

DMSO-EDTA buffer we use is a slight modification of the tissue buffer used by Seutin et 133	

al. (1991); we use 25% of DMSO, instead of 20% (with 25% of 0.5M EDTA, 50% sterile 134	

H20, saturated with sodium chloride).  Before being subjected to the preservation 135	

treatment, all samples were allowed to sit at room temperature for one of three time 136	

periods: preserved immediately after thawing (<10 minutes total thaw time), 3 hours after 137	

thawing, and 24 hours after thawing.  After 14 (crab) or 20 (fish) days, all sample tubes 138	

were moved into LN2 and stored until DNA was extracted.   139	

 140	

Temperature Experiment 1.3 141	

 Tissue samples were placed into one of five preservatives: 1 ml 95% EtOH, 1 ml 142	

DMSO-EDTA, 1 ml DNAzol, 1 ml RNAlater, 300 µl M2 lysis buffer and then stored for 143	

15 (crab) to 21 (fish) days at one of five temperatures: room temperature (RT), 4°C, -20° 144	

C, -80° C, and ~-190° C (LN2).  Subsequently, all sample tubes were stored in liquid 145	

nitrogen until DNA was extracted. 146	

 147	

DNA Extraction 1.4 148	

 All samples were digested overnight in 300 µl AutoGen M2 and 300 µl M1 buffer 149	

(including Proteinase K).  DNA was extracted from 300 µl (½ of the digested amount) of 150	

each digested sample by an AutoGen Prep 965 automated DNA extractor (AutoGen Inc.) 151	

using the manufacturers standard animal tissue (phenol-chloroform) extraction method, 152	
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and then dried.  Samples were eluted in either 100 µl (fish) or 50 µl (crab) R9 DNA re-153	

suspension solution (AutoGen Inc.).    154	

  155	

DNA Quantification 1.5 156	

 All sample extractions were quantified through fluorescence, using a BioTek 157	

Synergy HT Multi-Mode Microplate Reader and Quant-iT dsDNA Assay Kit, broad 158	

range (Invitrogen, Cat# Q33130).  Eight µl of eluted DNA was added to 200 µl of buffer 159	

and 1 µl of reagent in an opaque black 96-well microplate (Corning, Cat# 3915) and 160	

mixed thoroughly.  Ten µl of seven solutions with known dsDNA concentrations (0, 10, 161	

20, 40, 60, 80,  and 100 ng/µl) were each added to two wells on every plate to calculate 162	

standard concentration curves.  After sitting at room temperature for three minutes, 163	

samples were excited at 485 nm and ensuing fluorescence was read at 528 nm.  Each 164	

sample was read twice, with five minutes between reads, and reads were averaged. 165	

Duplicate fluorescence values from concentration standards were averaged, and a general 166	

linear model of these fluorescence values versus total known DNA amounts was 167	

calculated using the program R, with the intercept constrained to run through the origin. 168	

This model was then used to calculate the total ng of DNA in each sample.  The DNA 169	

concentration of the extraction was calculated by dividing total DNA by eight (the 170	

volume of sample used).  We also calculated the total DNA extracted by multiplying 171	

fluorescent sample total DNA by 12.5 (for fish, because it was eluted in 100 µl) or 6.25 172	

(for crab, because it was eluted in 50 µl).  Finally, we calculated a DNA extraction yield 173	

(ng DNA/mg Tissue) by dividing the total DNA extracted by the weight of each tissue 174	
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sample, and multiplying by two (because only half of each digest was used in the 175	

extraction). 176	

 177	

Statistical Analyses 1.6 178	

 Treatment differences were evaluated separately for each species (fish, crab) and 179	

experiment (Time, Temperature).  The program R was used to run two-factor Analyses of 180	

Covariance (ANCOVA) on the quality and quantity datasets separately. Analyses 181	

included a time or temperature by preservative interaction term and used tissue weight as 182	

a covariate.  If weight was non-significant, it was removed and the same ANCOVA, but 183	

without the covariate, was run.  In total, 14 analyses were conducted for each experiment.  184	

Therefore, a Bonferroni correction of ³ = 0.004 was used as a measure of significance. 185	

 186	

Gel Quantification: Greater than X kb 2.0 187	

 188	

Gel electrophoresis protocol 2.1 189	

 Extracted gDNA for all samples was visualized on a 1% agarose Tris-Borate-190	

EDTA (TBE) gel.  Five µl of each gDNA extract was loaded into the gel, and 191	

electrophoresed at 45 volts for 2.5 hours in 1X TBE buffer.  To estimate gDNA fragment 192	

length, 0.5–1 ug of HindIII ladder was loaded into wells on each side of the DNA-loaded 193	

wells.  After electrophoresis, gels were stained for 30 minutes in a solution of Ethidium 194	

Bromide (EtBr; at a final concentration of 0.5 µg/ml) and 1X TBE buffer.  Gels were 195	

subsequently de-stained (to reduce background staining) in H2O for 15 minutes.  Finally, 196	

gDNA was visualized, photographed and images were stored as TIFF files using a 197	
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Syngene Gene GeneGenius Bio Imaging System.   198	

 Additionally, because EtBr is carcinogenic, and many labs are moving away from 199	

its use and replacing it with safer methods, we also optimized the gel electrophoresis 200	

protocol with GelRedTM (BioTium).  For this method, we recommend a 0.7% agarose 201	

Tris-Borate-EDTA (TBE) gel, run for ~2.5 hours at 45 volts in 1X TBE buffer.  When 202	

using GelRedTM, we recommend loading a few wells of diluted HindIII ladder in various 203	

amounts (e.g. 1:24, 1:49, and 1:99) because the GelRedTM can cause wide smearing in the 204	

HindIII ladder bands (Fig. 1).  For either staining method, it is important to have HindIII 205	

ladder on either ends of the gDNA, such that it "brackets" the gDNA samples on either 206	

end for post-scoring of the gel images (Fig. 1). 207	

 208	

Scoring of the Gels 2.2 209	

Specific, step-by-step instructions can be found on the online Supplementary Information 210	

Appendix I. 211	

 212	

 To visualize and score the gel images, we used the program ImageJ v1.48 (W. 213	

Rasband, NIH).  ImageJ is an open-source, Java based program in the public domain, 214	

available at http://rsb.info.nih.gov/ij.  Gel image files are opened in ImageJ, with the 215	

wells of the gel at the top.  The gel image is color inverted to enhance visualization of the 216	

bands and make density curves positive, rather than negative (see below).  The image is 217	

made level with respect to the top band in each ladder on either side of the gDNA 218	

samples, the background is subtracted to remove smooth continuous backgrounds from 219	

the gel images.  Next, a vertical box is drawn encompassing the entire length of the lane 220	
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containing HindIII ladder, starting below the well, above the ~23 kb band, and to the 221	

extent of the gDNA (Fig. 1A).  Vertically, the box should encompass the entire length of 222	

the smallest fragments of the gDNA lane on the gel with the greatest range.    223	

 The HindIII ladder box on the left is selected as the first lane.  If using multiple 224	

dilutions of HindIII ladder, select the dilution that has the clearest bands on both sides of 225	

your gDNA samples.  The box over the HindIII ladder is then moved to the first gDNA 226	

lane, and this lane is selected as the next to be analyzed (note: when moved, the original 227	

box stays in place and a new one is placed over the next lane).  The horizontal location of 228	

this box must be carefully selected, so that the bands (or smears) of gDNA encompass the 229	

entire width of the box.  The program automatically adjusts the vertical placement to be 230	

level with the first box.  Then, the box from the first gDNA lane is moved to the next 231	

gDNA lane to be scored (typically, the next one to the right), again carefully selecting the 232	

location of the new lane horizontally, centering the box on the gDNA.  Additional gDNA 233	

lanes are selected from left to right, by dragging the previous box from the left to the 234	

right, and selecting "Next Lane," until all desired lanes are included.  The last lane 235	

selected must be the HindIII ladder to the right of gDNA lanes (Fig. 1A). An "Intensity 236	

Plot" is then created of the selected lanes, including the HindIII ladder lanes.   237	

 The Intensity Plot opens in a new window and is rotated 90° clockwise from the 238	

gel orientation (i.e. the leftmost lane becomes the top intensity plot).  A straight line is 239	

drawn for the DNA size threshold (Fig. 1B) from the apex of the ladder threshold peak 240	

(e.g. "9 kb") on the first ladder (top of the Intensity Plot) to the apex of the ladder 241	

threshold peak on the second ladder (bottom of the Intensity Plot).  This separates the 242	

intensity curves of each lane into a region greater than the threshold peak (Fig. 1C) and a 243	
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region less than the size of the threshold peak (Fig. 1D).  All regions must be closed to be 244	

measurable; if the right side of the intensity curve does not meet the vertical line at the 245	

right side of the plot (leaving this region open), the Straight tool is used to draw a vertical 246	

line connecting the right part of the curve to the border of the plot.  247	

 The Wand tool is then used to select and measure the area of a region under the 248	

Intensity Plot, on the left side of the vertical line (>9 kb) and to the right of the vertical 249	

line (<9 kb).  Once selected, the area is automatically calculated and presented in a 250	

Results table (Fig. 1E). If a dark imperfection appears in the gel that is clearly not part of 251	

the gDNA (Fig. 1A, gDNA II), a peak is recorded in the Intensity Plot.  Similar to closing 252	

areas to measure (described above), one can eliminate the erroneous peak by using the 253	

Straight tool (Fig. 1F), and recalculate the area (Fig. 1G). The numbers in the Results 254	

window are the areas of the curve greater and less than the size of the threshold peak, 255	

respectively (Fig. 1E).  These data are then copied and pasted into a data processing file 256	

and the percentage of the area greater than the chosen peak (e.g. ~ 9 kb) is easily 257	

calculated by dividing the area to the left (> 9 kb), by the total area.   258	

 259	

Scoring Tests 2.3 260	

 We ran two analyses to test the repeatability (the variation obtained when one 261	

person measures samples repeatedly using the same methods) and reproducibility (the 262	

variation obtained when multiple people measure samples repeatedly using the same 263	

methods) of our gel scoring method.  In the first analysis,  two co-authors (CM and KSM) 264	

each independently scored the same gel image (FishTime  <10 min) consisting of 40 265	

lanes of gDNA, 10 times.  For each scoring, the entire process was repeated, starting with 266	
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opening the raw image in ImageJ.  Additionally, each scoring process was timed to give 267	

an estimate of method efficiency.  The results of the 20 scored gel images (consisting of 268	

800 scored gDNA lanes) were analyzed using a Gage repeatability and reproducibility 269	

ANOVA (Gage R&R) using the spreadsheet devised by J. Muelaner 270	

(www.muelaner.com/quality-assurance/gage-r-and-r-excel/).   In order to test the 271	

consistency of dDNA in the gels, for the second analysis we ran seven gDNA samples, 272	

four crab (from Time  <10 min) and three fish (from Temp = 4°C), each multiple times 273	

on two different gels.  Each crab sample was run three times on each gel, while each fish 274	

sample was run four times on each gel.  The gel images were also independently scored 275	

by two co-authors (DM and KSM), and the results of this test were also analyzed using a 276	

Gage R&R. 277	

 278	

Results 279	

 280	

Time Experiment 281	

 282	

Figure 2A shows the fish gDNA extractions run out on a gel with the HindIII ladder from 283	

the seven preservation methods at time <10 mins after death.  The DMSO-EDTA and 284	

DNAzol buffers have the greatest percent of gDNA > 9 kb (72% and 87%, respectively), 285	

consistent with the gel patterns showing the largest bands of gDNA, with little streaking 286	

or smearing in the lanes, indicating very little fragmented DNA.  Figure 2B shows the 287	

results of the fish gDNA extractions from samples preserved at room temperature in 95% 288	

EtOH at <10 minutes, three hours, and 24 hours after death before being frozen in LN2.  289	
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The gDNA degrades through time resulting in little to no high molecular weight DNA 290	

after 24 hours (Fig. 2B).   291	

 Figure 3 shows the gel image of the crab gDNA for time <10 mins., for seven 292	

different preservation methods. The EtOH, DMSO, and DNAzol gDNAs have the 293	

greatest percentage of gDNA > 9kb (93%, 93%, 100%, respectively), and show less 294	

smearing and larger fragment size than RNAlater, -20°C, -190°C, and M2. 295	

 Average measures of quantities, concentrations, and quality (as measured by % of 296	

DNA > 9,416 bp) are shown for each trial for the time experiment for the fish and crab 297	

gDNA extractions in Table 1.  Figures 4 and 5 show the quality of fish and crab gDNA 298	

(% > 9 kb), respectively, for seven different preservation methods over three time 299	

periods.  DNA quality varies greatly in both taxa at time <10 mins., but all methods show 300	

degradation in quality of gDNA over time for both fish and crab tissues. 301	

 302	

 303	

Temperature Experiment 304	

 305	

 Figure 6A shows the fish gDNA extractions electrophoresed on a gel with the 306	

HindIII ladder from five different preservation methods at room temperature.  Note the 307	

DMSO-EDTA, DNAzol, and RNAlater buffers have the greatest percentage of gDNA > 308	

9kb (89%, 98%, 100%, respectively), and show the largest bands of gDNA with little 309	

streaking or smearing in the lanes, indicating very little fragmented gDNA.  Figure 6B 310	

shows the results of the fish gDNA extractions electrophoresed on a gel (with the HindIII 311	

ladder) from the five different temperatures the tissue were stored at while in the DMSO-312	
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EDTA buffer.  Figure 7 shows the gel image of the crab gDNA for the different 313	

preservation methods stored at room temperature.  Average measures of quantities, 314	

concentrations, and quality (as measured by % of DNA > 9,416 bp) are shown for each 315	

trial for the temperature experiment for the fish and crab gDNA extractions in Table 2.  316	

Figures 8 and 9 show the quality of fish and crab gDNA (% > 9 kb), respectively, for the 317	

different preservation methods over the five temperatures at which tissues were stored.   318	

 319	

 320	

ANCOVA Statistics 321	

 322	

 Table 3 shows the results of the analysis of covariance statistics for the fish and 323	

crab, Time and Temperature experiments, for both quality (% of gDNA > 9 kb) and 324	

quantity (ng gDNA/mg tissue) of gDNA.   In the fish Time Experiment, time, 325	

preservation method, and the interaction variable all significantly affected DNA quality, 326	

while only time had a significant affect on quantity.  For both quality and quantity, the 327	

covariate weight was marginally insignificant.  In the crab Time Experiment, all factors 328	

(time, preservative, time x preservative, weight) significantly affected gDNA quality. The 329	

interactive term was significant only for gDNA quantity, although preservation method 330	

was just marginally insignificant.  For the fish Temperature Experiment, only 331	

preservation method significantly affected gDNA quality, while temp, preservation 332	

method and weight all affected quantity.  Finally, in the crab Temperature Experiment, 333	

only preservation method significantly affected either quality or quantity, although 334	

weight was marginally insignificant for both (Table 3). 335	
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 336	

Repeatability and Reproducibility 337	

 338	

The first (single gel) test resulted in the repeatability variation (the % of total variation 339	

that is attributable to the scorer, i.e. the variability among the 10 scores a single co-author 340	

gave the same sample) of 3.99% and reproducibility variation (the % of total variation 341	

attributable to differences in the way the co-authors scored the same sample) of 5.71%.  342	

The total Gage Repeatability and Reproducibility variation was 6.97%.  The second 343	

(multiple gel) test had a repeatability variation of 22%, a reproducibility variation of 344	

18.1%, and a total Gage R&R variation of 28.5%. 345	

 346	

Discussion 347	

 348	

Greater than X kb 349	

 350	

Here we demonstrate a simple, consistent, and efficient method for determining the size 351	

and quality of genomic DNA that does not require expensive equipment or reagents.  352	

Previous studies have presented the effects of different preservation conditions on DNA 353	

without providing an objective metric for genomic quality as we have done (e.g., Gaither 354	

et al., 2011; Camacho-Sanchez et al., 2013).  We propose this method as a heuristic 355	

standard for biodiversity biobanking facilities and the genomic community, which may 356	

desire an initial assessment of DNA quality before requesting tissue samples.  Using this 357	

method, genomic DNA can be electrophoresed on an agarose gel with a HindIII ladder, 358	
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or any other large-sized DNA marker, and quantified using simple plots in the free 359	

software ImageJ (W. Rasband, NIH: http://rsb.info.nih.gov/ij.).  360	

 We tested whether a single, or multiple researchers could reliably score a gel 361	

image similarly multiple times using a using a Gage Repeatability and Reproducibility 362	

ANOVA. The Gage R&R evaluates repeatability by the amount of variation attributable 363	

to a single measurer through multiple measures of the same sample, and evaluates 364	

reproducibility by the amount of variation attributable to differences between measurers.  365	

The analysis also calculates an overall measure of repeatability and reproducibility (the 366	

total Gage R&R), where most guidelines consider any total Gage R&R values under 10% 367	

to be acceptable, and any total values under 30% to be acceptable under certain 368	

conditions (Pan, 2006).  For this test, the repeatability variation was 3.99%, the 369	

reproducibility variation was 5.7%, and the Total Gage R&R was 6.97%.  Both 370	

researchers gave the same sample image similar quality scores (though not surprisingly, 371	

quality scores were slightly more different between researchers than were scores by the 372	

same researcher) to an extent acceptable to most quality control applications.   373	

 We conducted a second test to evaluate quality scores from samples run multiple 374	

times on a gel, and on separate gels.  Our Gage R&R variability was much higher for this 375	

experiment, with a repeatability variation of 22%, a reproducibility of 18%, and a Total 376	

Gage R&R variation of 28.5%.  There are many factors that can affect these scores in 377	

addition to measurer variability, such as variation in image quality (camera exposure, 378	

focus, dynamic range), variation in gel staining (length of time, mixing of stain, type of 379	

stain), and pipetting variation. Minor nuances between gel runs can result in slight 380	
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discrepancies of quality scores, but in our case most values of the same sample were 381	

within ~5% of individual scores. 382	

 For the purposes of demonstrating the method, we chose the 9,416 bp (~"9 kb") 383	

size marker from HindIII as the standard, and reported the percentage of genomic DNA 384	

greater than 9 kb, with the recognition of 50% or more of the gDNA being greater than 9 385	

kb as a candidate indicator of "genomic quality."  Although other fragment sizes could be 386	

chosen, in our experience of legacy biorepository samples, many gDNA extractions will 387	

fail to meet a higher standard. NextGen sequencing techniques are capable of much 388	

longer reads than 9 kb (Loman and Quinlan, 2014); therefore, threshold measures of 389	

genomic quality will be useful to the field of biodiversity genomics. 390	

 Moreover, this method does not depend on the choice of fragment size as a 391	

threshold for “genomic quality.” One could as well pick the HindIII 564, 2,027 or other 392	

fragment sizes as a standard.  From the point of view of a biodiversity tissue and DNA 393	

repository, whose samples may be been collected years ago and under difficult field 394	

conditions, or whose future samples may require difficult field conditions, we propose 395	

that 9 kb is, given current technology, a pragmatic value. Whatever the standard chosen, 396	

the threshold percentage of gDNA also implies that the extraction will contain fragments 397	

much larger than the actual threshold value. Importantly, the "DNA Threshold" and the 398	

"Percent above Threshold" standards (http://terms.tdwg.org/wiki/GGBN_Data_Standard - 399	

GGBN_Gel_Image_Vocabulary) provide a computable number for comparative values. 400	

These values coupled with the gel images allow the researcher to reach their own 401	

conclusions on the quality of gDNA for their specific needs.   402	
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 Of course, genomic DNA of many small organisms, such as certain arthropods, 403	

nematodes, meiofauna, and other microscopic organisms is generally difficult to visualize 404	

on agarose gels, yet suitable amounts of genomic sequence data can be successfully 405	

amplified from such organisms (e.g. Blaimer et al., 2015).  We also realize that 406	

"degraded" gDNA, < 9 kb for example, can still be used for myriad analyses (e.g. 407	

sequence capture, ultra-conserved elements, etc.), including complete genome 408	

sequencing, such as the Neanderthal genome (Prüfer et al., 2014).  Indeed, ancient DNA 409	

rarely exceeds 100 bp.  However, as biodiversity scientists seek to preserve samples from 410	

all major clades of the tree of life, from all biomes, practical and economical field 411	

techniques must be developed, and in turn, the effectiveness of such techniques should be 412	

quantitative. 413	

 Whole genome sequencing will advance technically to use very long fragment 414	

sizes, as longer reads provide higher quality assemblies (Schatz et al., 2010).  Therefore, 415	

for plants and animals that can easily be visualized on an agarose gel, we recommend the 416	

"greater than X kb" method as a standard for biodiversity biobanking laboratories to 417	

report the quality of gDNA extracts.   418	

 Typically, most library preparation methods to date begin with shearing gDNA to 419	

sizes compatible with the maximum size range of most NextGen sequencing platforms 420	

(e.g. 300–500 bp).  Therefore, one might question why we should be concerned with 421	

large pieces of intact gDNA prior to library preparation.  Mechanical shearing, or 422	

sonication, shear gDNA randomly across the genome, whereas degradation can cause 423	

shearing in non-random places, and in the same places repeatedly, possibly leading to 424	

biased NextGen results (Zackin and Ge 2010; Choi et al., 2002).  Furthermore, the use of 425	
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large insert mate-pair libraries up to 25 kb can increase the efficiency of genomic 426	

structure analyses (van Heesch et al., 2013). 427	

 428	

Preservation Methods 429	

 430	

 In our tests, salt-saturated DMSO/EDTA buffer and DNAzol are better at 431	

preserving high-quality (> 9 kb) gDNA than other methods such as direct storage in 432	

liquid nitrogen (-190° C) or -20° C storage (Fig. 2A and Fig. 3; Table 3).   Saturating 433	

tissues with storage buffer immediately is also important, as significant DNA degradation 434	

can occur, even within three hours time after death (Fig. 2B and Figs. 4–5; Table 3).  435	

Temperature appears to have less of an effect on tissue preservation for overall size-436	

quality of gDNA (Figs. 8–9; Table 3).  Therefore, time before preservation and 437	

preservation method (buffer vs. frozen), and interactions between these factors, have the 438	

biggest influence on gDNA quality when measured as size, for both the fish and crab 439	

tissue samples (Table 3). 440	

 Currently, many genetic researchers working on non-model organisms are under 441	

the impression that directly freezing fresh tissue is the best way to preserve gDNA, and 442	

the faster and colder the method of preservation, the better (e.g. Wong et al., 2012).  443	

Liquid nitrogen can be expensive, and both liquid nitrogen and dry ice can be difficult to 444	

obtain and transport in certain countries and under remote field conditions.  Our results 445	

show that putting tissue directly into buffers, such as the salt-saturated DMSO/EDTA or 446	

DNAzol is actually better than directly into liquid nitrogen or -20° C storage, without any 447	

buffer for fish (Figs. 4; Table 1), and putting tissues directly into buffers or liquid 448	
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nitrogen alone is far better than -20° C storage for the crab (Fig. 5); albeit all of our 449	

samples were flash-frozen first in liquid nitrogen without any buffers prior to treatment.   450	

 This is good news for molecular biologists collecting field samples of genomic 451	

material.  Salt-saturated DMSO/EDTA is easy and inexpensive to make in the lab and is 452	

more easily transported than reagents such as 95% EtOH.  We suspect, based on our 453	

observations, that the best method of preservation is to allow fresh tissue material to soak 454	

in the salt-saturated DMSO/EDTA buffer for approximately 1 hr. (depending on amount 455	

of tissue) and then preserving it in liquid nitrogen, or -20° C for transportation and/or 456	

long term storage. 457	

 Interestingly, 95% EtOH appears to be just as good as DMSO for preserving 458	

DNA quality in crab tissue (Fig. 5), but not so for fish (Fig. 4).  Ethanol can cause 459	

extensive, crude dehydration of animal tissues, which may cause fragmentation of gDNA 460	

(Gaither et al., 2011).  Some research supports that ethanol performs better in invertebrate 461	

tissues (Williams, 2007), perhaps in insects because it can more easily penetrate the 462	

cuticle and exoskeletons. Our crab tissue was removed from the shell prior to 463	

preservation, which may have improved the performance of EtOH in our study.  464	

Regardless, the DMSO/EDTA buffer and 95% EtOH each performed better than direct 465	

cryopreservation for the fish and crab tissues, respectively. 466	

 Challenges of sufficient amounts of total DNA extracted and concentration (ng 467	

DNA/mg tissue) can be overcome by increasing the amount of starting material, and/or 468	

combining extractions from several separate extractions of the same starting material 469	

source.  Here, we have shown that time since death is the biggest factor in gDNA 470	

concentration for the fish, but this does not seem to be a factor for the crab  tissue (Table 471	
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3).  Temperature is important for the preservation of fish tissue in terms of quantity 472	

(Table 3).   473	

 Our study was limited to a small number of organisms, one vertebrate, the white 474	

perch (Morone americana) and one marine invertebrate, the blue crab (Callinectes 475	

sapidus).  Ideally, we would like to see our methods tested for a variety of organisms, 476	

including vascular plants, algae, and terrestrial invertebrates.   Ultimately, we would like 477	

to see tests of methods of genomic DNA preservation for all groups of life.    478	
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Tables 

Table 1. Time Experiment.  Average quantities of Extracted DNA (ng), DNA extraction yield (ng DNA/mg tissue digested; see text 

for method of calculation) and Quality (% DNA > 9,416 bp) of genomic DNA extracted from tissues of two species of fish (Morone 

americana) and crab (Callinectes sapidus) held in one of 21 treatments: three times prior to preservation (<10 min, 3 hrs, 24 hrs), then 

stored in seven preservative methods (95% EtOH, DMSO-EDTA, DNAzol, RNAlater, M2, -20°C, and -190°C) for a minimum of 14 

days. Mean and standard deviation (SD) values are shown. 

 

  < 10 min 3 hrs 24 hrs 

 Extracted DNA 

(ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

Extracted DNA 

(ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

Extracted 

DNA (ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

  Mean SD Mean 

S

D Mean 

S

D Mean SD Mean 

S

D Mean SD Mean SD Mean 

S

D Mean 

S

D 

                       Fish: Morone americana 

               EtOH 186 28 78 10 6 3 209 49 83 18 4 4 98 14 40 7 1 2 

DMSO 183 57 81 20 72 10 171 94 71 40 25 8 13 5 6 2 0 0 

DNAzol 244 170 108 71 87 5 157 25 63 12 34 8 14 4 6 2 0 0 

RNAlate

r 182 17 81 8 7 6 180 36 72 20 0 0 86 37 38 18 0 0 

M2 214 44 101 21 35 20 174 31 79 13 4 4 84 18 40 8 3 5 

-20°C 236 37 102 15 7 5 166 29 69 11 1 2 110 45 49 19 2 5 

-190°C 191 44 84 15 3 2 165 24 70 10 0 2 137 43 59 18 0 0 

                                            Crab: Callinectes 

sapidus   

               EtOH 97 48 22 10 93 5 369 312 79 64 46 36 303 94 61 17 1 1 

DMSO 38 11 8 3 93 13 136 85 30 15 48 22 28 15 5 2 0 0 

DNAzol 34 28 8 7 100 0 130 108 28 23 20 10 14 4 3 1 0 0 

RNAlate

r 140 74 28 14 81 17 231 126 52 30 53 37 184 33 35 7 0 0 

M2 119 88 34 26 75 18 250 114 64 29 56 32 31 40 8 10 0 0 

-20°C 275 56 58 12 17 16 278 143 70 43 26 37 196 66 43 7 0 0 

-190°C 209 112 44 23 72 16 381 214 90 47 49 36 102 141 19 26 0 0 

PeerJ Preprints | https://doi.org/10.7287/peerj.preprints.2202v1 | CC BY 4.0 Open Access | rec: 1 Jul 2016, publ: 1 Jul 2016



	 30	

 

Table 2.  Temperature Experiment.  Average quantities of Extracted DNA (ng),  DNA extraction yield (ng DNA/mg tissue digested, 

see text for method of calculation) and Quality (% DNA > 9416 bp) of genomic DNA extracted from tissues of two species fish 

(Morone americana) and crab (Callinectes sapidus) held in one of 25 treatments: five  storage temperatures (Room Temperature = 

RT, 4°C, -20°C, -80°C, and -190°C)  x five preservative methods (95% EtOH, DMSO-EDTA, DNAzol, RNAlater, M2) for a 

minimum of 14 days. Mean and standard deviation (SD) values are shown. 

 

 

  RT 4°C -20°C 

  

Extracted 

DNA (ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

Extracted 

DNA (ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

Extracted 

DNA (ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

  Mean SD Mean SD Mean SD Mean SD Mean SD Mean SD Mean SD Mean SD Mean SD 

            Fish: Morone americana 

 

           

             EtOH 233 129 150 69 46 18 229 87 157 54 23 12 188 38 120 23 41 11 

DMSO 375 170 248 96 89 10 295 116 196 66 89 8 309 155 208 108 94 6 

DNAzol 298 177 194 109 98 4 297 114 192 74 83 15 294 143 202 90 96 6 

RNAlater 173 127 125 102 100 0 169 44 109 23 59 14 160 28 111 13 81 6 

M2 161 73 110 52 82 4 180 33 134 18 30 17 188 87 142 64 80 10 

                   Crab: Callinectes sapidus   

               EtOH 1238 354 430 112 52 35 889 190 329 81 62 24 804 432 291 159 39 14 

DMSO 888 367 320 155 79 6 388 162 141 54 37 20 727 345 257 98 45 27 

DNAzol 643 252 242 100 90 10 705 436 257 177 77 27 511 371 171 110 NA NA 

RNAlater 641 175 229 56 62 23 704 242 271 108 55 11 399 131 142 50 54 7 

M2 582 166 222 67 84 15 606 282 227 105 73 21 750 194 268 81 59 19 
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Table 2 (continued). 

  -80°C -190°C 

  

Extracted 

DNA (ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

Extracted 

DNA (ng) 

Extraction 

Yield (ng 

DNA/mg 

Tissue) 

Quality         

(%  > 9416 

bp) 

  Mean SD Mean SD Mean SD Mean SD Mean SD Mean SD 

            Fish: Morone americana 

         EtOH 159 31 105 17 49 24 306 105 209 71 32 17 

DMSO 372 192 263 132 95 13 488 244 326 189 82 20 

DNAzol 447 184 307 127 100 0 609 238 403 157 40 42 

RNAlater 184 78 125 57 77 10 174 61 117 35 71 23 

M2 164 45 116 31 88 6 269 66 172 33 63 13 

             Crab: Callinectes sapidus   

         EtOH 1264 580 415 173 24 4 942 222 320 87 77 24 

DMSO 864 472 308 186 24 3 715 284 241 101 49 28 

DNAzol 920 270 332 110 28 3 432 213 151 72 91 12 

RNAlater 772 667 289 271 36 16 532 320 178 90 65 24 

M2 848 474 309 171 78 23 1024 273 336 93 60 28 
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Table 3.  Summary of ANCOVA results for Time and Temperature experiments.  Covariance was tested for between Time, 

Preservation method (Pres.), and Weight (Wt.) for the Time experiments and Temperature (Temp.), Preservation method (Pres.), and 

Weight (Wt.) for the Temperature experiments.  Interactions (Int.) were tested for between Time and Temp. and Pres., if weight was 

not significant it was removed. A Bonferroni correction of ³ = 0.004 is used. Significant results are shown in boldface font. 

 

    Time Experiment   Temperature Experiment 

Fish: 

 

Time Pres. Wt. Int. 

 

Temp. Pres. Wt. Int. 

Morone americana Quality <0.001 <0.001 0.0074 <0.001 
 

0.0408 <0.001 0.2079 0.8923 

  

<0.001 <0.001 
 

<0.001 
 

0.0339 <0.001 
 

0.9260 

           

 

Quantity <0.001 0.0452 0.0743 0.0220 
 

<0.001 0.0026 <0.001 0.7179 

  

<0.001 0.0505 
 

0.043 
     

Crab:           

Callinectes sapidus Quality <0.001 0.0022 0.0010 0.0014 
 

0.0197 <0.001 0.0607 0.5840 

  
     

0.0081 <0.001 
 

0.5550 

  
         

 

Quantity 0.6902 0.0099 0.5916 <0.00191 
 

0.7545 <0.001 0.0129 0.0568 

    0.7591 0.0135   0.0015   0.4273 <0.001   0.0481 
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Figures 

 

 

 

 

Figure 1.  Scoring a gDNA gel in ImageJ.  A) An inverted gDNA gel image with the 

HindIII ladder in wells 1–2 (wells labeled on bottom) and 7, and gDNA samples (I–IV) in 

wells 3–6.  The bands in  the HindIII ladder are labeled in well 1; note the ~2 kb bands 

are visible in this lane, but not in the more diluted lanes (2 and 7; see text).  B) The Plot 

results of the six yellow boxes scored in A), with the Straight tool line spanning the ~9 kb 

peaks of the two HindIII ladders (wells 2 and 7, top and bottom, respectively), with the 

four gDNA samples in the middle.  C) The area calculated for > 9 kb.  D) The area < 9kb.  

E) The Results box, with values 1 and 2 for the areas > 9 kb and < 9kb for gDNA sample 

I, respectively.  F) The Straight tool line used to eliminate peak cause by flaw in gel for 

gDNA sample II.  G) The calculated area < 9kb with the erroneous peak removed.  The 

percent of gDNA > 9kb is calculated by dividing the area > 9kb (C) by the total area 

below the curve (C + D).  
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A)  

B)  

Figure 2.  Gel image of extracted gDNA from the white perch, Morone americana for the 

Time Experiment.  The ladder in the left- and right-most lanes is the HindIII with bands 

at 564, 2027, 2322, 4361, 6557, 9416, and 23130 bp.  A) Samples in all tissue storage 

treatments for Time-since-death <10 minutes: 1) in EtOH; 2) in salt saturated 

DMSO/EDTA preservation buffer ("DMSO"); 3) submerged in DNAzol Reagent 

(Invitrogen); 4) submerged in RNAlater (Ambion); 5) submerged in M2 tissue digestion 

solution (Autogen); 6) held at -20°C with no preservation solution; 7) submerged in 

liquid nitrogen (j-190°C) with no preservation solution. B) Samples in Time-since-death 

treatments for EtOH tissue storage treatment are shown for the three different time 

periods (< 10 mins., 3 hrs., 24 hrs.).   
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Figure 3. Gel image of extracted genomic DNA from the blue crab, Callinectes sapidus, 

for the Time Experiment, showing all tissue storage treatments for Time-since-death <10 

minutes.  The HindIII ladder is shown in the left- and right-most lanes of the gel.  
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Figure 4.  Graph of Fish Time Experiment.  Quality of gDNA extracted from the white 

perch, Morone americana.  Quality is shown as the mean % of gDNA > 9,416 bp on the 

y-axis. Preservation treatments are differentiated by symbols (see lgend).  Time-since-

death treatments are shown on the x-axis for the three time periods tissue samples sat 

before preservation. See Table 1 for exact values of each method. 
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Figure 5.  Graph of Crab Time Experiment.  Quality of gDNA extracted from the blue 

crab, Callinectes sapidus.  Quality of extracted gDNA is shown as the mean % of DNA > 

9,416 bp on the y-axis. Preservation treatments are differentiated by symbols. Time-

since-death differentiated are shown on the x-axis for the three time periods tissue 

samples sat before preservation. See Table 1 for exact values of each method.  
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A)  

B)  

Figure 6.  Gel image of extracted gDNA for the white perch, Morone americana, for the 

Temperature Experiment. Prior to DNA extraction, tissue was stored for 14–20 days in 

one of five solutions (EtOH, DMSO, DNAzol, RNAlater, M2) and kept at one of five 

temperatures: Room Temperature, -20°C, -80°C, -190°C.  A). Showing all tissue storage 

buffer treatments for tissue storage at Room Temperature.  B). Showing all tissue storage 

temperature treatments for DMSO-EDTA salt buffer.  
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Figure 7. Gel image of extracted genomic DNA for the blue crab, Callinectes sapidus for 

preservation Temperature Experiment, showing all tissue storage buffer treatments for 

tissue storage at room temperature.   
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Figure 8.  Graph of Fish Temperature Experiment.  Quality of gDNA extracted from 

white perch, Morone americana.  Quality of extracted gDNA is shown as the mean % of 

gDNA > 9,416 bp on y-axis.  Preservation solutions are differentiated by symbols (see 

legend), with the different preservation temperatures on the x-axis. See Table 2 for exact 

values of each temperature.  
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Figure 9.  Graph of Crab Temperature Experiment.  Quality of gDNA extracted from the 

blue crab, Callinectes sapidus.  Quality of extracted gDNA is shown as the mean % of 

gDNA > 9,416 bp on the y-axis. Preservation treatments are differentiated by symbols. 

Temperatures are shown on the x-axis for the five temperatures tissue samples were held 

after preservation. See Table 2 for exact values of each temperature. 
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Supplementary Information: Mulcahy et al., PeerJ 

 

Protocol for using ImageJ to determine relative band size of DNA from gel images 

 

 

1. Download Program:  Download Java program ImageJ from 

http://rsb.info.nih.gov/ij 

2. Open Image:  Open raw image file in ImageJ with ;o or using the menu 

(File>Open). 

3. Invert Image:  Invert the image with shift+i.  This is not necessary, but I find that 

it is easier to see the limits of bands with an inverted image, and it makes the 

density curves that we will create positive rather than negative.  It also makes 

Step 4 (image leveling) significantly easier. 

4. Level Image:  Make sure lanes in your image are horizontally level using the 

menu (Image>Transform>Rotate).  This brings up a dialog that allows you to 

rotate the image by degrees (positive numbers for clockwise rotation, negative 

numbers for counterclockwise rotation).  To determine if rotation is necessary, 

select the Preview box, set the Angle to 0, and increase the Grid Lines value.  

This allows you to compare your lanes to the horizontal and vertical lines of the 

grid.  Change the Angle value until the lanes in your image are horizontally level 

(i.e. you want the top bands in both ladders to be level).   

5. Subtract Background:  Subtract background from image using the menu 

(Process>Subtract Background).  A pop-up window will open.  Make sure that the 

box for Light Background is checked, as well as the box for Preview.  Choose the 

Rolling ball radius that gives the whitest background without degrading DNA 

signal.  Usually the default (50.0 pixels) works fine, but you may want to play 

with this.  If you use too low of a value, you start to lose dark pixels at the edges 

of the DNA bands, but you want the lowest value obtainable without losing dark 

pixels. 

6. Select Rectangle Tool:  Select the Rectangle tool from the toolbar 

7. Draw Box Encompassing Ladder:  Draw a rectangle on the lane of the first 

ladder.  The bands of the ladder should cross the entire width of the drawn box, so 

make the box as narrow as possible.  Vertically, the box should encompass the 

entire DNA band of the lane on your gel with the greatest vertical range (but do 

not include the well in the box).  In other words, there should be no white space 

on the left or right sides between the DNA band and the sides of the drawn box, 

but there should be white space between the longest band and the top of the box, 

and white space between the shortest band and the bottom of the box. If you make 

a mistake in drawing boxes or selecting lanes and need to start over, this can be 

done via the menu (Analyze>Gels>Reset)  

8. Select Box as First Lane:  Select this lane as the first lane to be analyzed using 

;1.  This can also be accomplished using the menu (Analyze>Gels>Select First 

Lane) 

9. Select Next Lane:  Drag the box to the next lane to be measured, and select this 

lane as the next to be analyzed using ;2.  This can also be accomplished using 

the menu (Analyze>Gels>Select Second Lane). When you drag the box to the 

PeerJ Preprints | https://doi.org/10.7287/peerj.preprints.2202v1 | CC BY 4.0 Open Access | rec: 1 Jul 2016, publ: 1 Jul 2016



new lane, carefully select the location of the new lane horizontally, attempting to 

center the box on the bands (as in Step 8).  You do not have to be as careful with 

vertical placement of the box: ImageJ will automatically align new boxes 

vertically as you select them. 

10. Select all Lanes:  Repeat Step 9 for all lanes that you wish to analyze.  Make sure 

that the last lane selected is the last ladder.  It doesn’t matter which ladder is 

selected first, and which is selected last, as long as they are the first and last 

selected. 

11. Create Intensity Plot:  Create intensity plot of the selected lanes using ;3. This 

can also be accomplished using the menu (Analyze>Gels>Plot).  If you need to 

remake the intensity plot, close the current plot, make the gel image the active 

window, and use the menu (Analyze>Gels>Re-Plot Lanes).  This will give you a 

new, clean intensity plot. 

12. Draw Line for DNA Size Cutoff:  From the toolbar, choose the Straight tool.  

Draw vertical line on the intensity plot from the apex of the ladder peak of choice 

on the first ladder (top of page) to the apex of the ladder peak of choice on the 

second ladder (bottom of page).  This separates the intensity curves of each lane 

into a region greater than the size of the peak chosen and a region less than the 

size of the peak chosen.   

13. Close All Regions to Measure:  All regions under the intensity curves must be 

closed to measure area, but you will notice that the right side of the intensity 

curve does not meet the vertical line at the right side of the plot, leaving this 

region open.  To fix this, with the Vertical tool still selected, draw a vertical line 

from the furthest right part of the curve on the first ladder to the furthest right part 

of the curve on the last ladder. This may have to be repeated on the left side of the 

curve if it doesn’t meet the left side of the plot.  You will know if this is necessary 

if, during Step 14, the Wand tool highlights more than just the area under the 

curve.  

14. Select Region Above Cut-off for First Measurement:  Choose the Wand tool 

from the toolbar.  Select the region under the intensity curve on the left side of the 

vertical line from Step 12 for your first sample.   

15. Measure First Region:  Some users may find that an area measurement is 

automatically taken when the region is selected using the Wand tool.  If a new 

box (labeled “Results”) appears when you select a region, then measurements are 

automatic.  If no “Results” box appears, you need to tell ImageJ to measure each 

region with ;m, or using the menu (Analyze>Measure). The number in the 

results window is the area of the curve greater than the size of the peak chosen.  If 

you need to measure multiple areas (i.e. the curve reaches the lower limit of the 

graph, essentially splitting up the region), select each while holding shift, then 

measure after all regions have been selected.  If measurements are automatic, you 

cannot select multiple regions before measuring.  Instead, measure each region 

separately and add them together to get the area of the entire curve 

16. Select and Measure Region Below Cut-Off:  Repeat Steps 14 and 15 with the 

region under the intensity curve on the right side of the vertical line. This is the 

area of the curve less than the size of the peak chosen, and should appear in the 

“Results” window, below the first value.  Note that ImageJ numbers the 
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measurements sequentially as they are made, so keep track of which value 

belongs to each curve area measurement.  

17. Measure All Regions:  Repeat Step 14 through Step 16 for each sample.   

18. Save Results:  Save the Results table with ;s or using the menu (File>Save As). 

By default, ImageJ saves the table as a tab-delimited file with an excel (.xls) 

extension. 

19. Calculate Proportion:  For each sample, add the two portions (left and right) to 

get the total area under the curve. Divide the first area value (area to the left of the 

peak) by the total area to obtain the % of area under the curve greater than the size 

chosen. 

 

 

Notes: 

This protocol is for usage on a Mac, usage on a PC is similar (replace ; with Ctrl for 

keyboard shortcuts).  

 

The ImageJ users guide can be viewed at http://rsb.info.nih.gov/ij/docs/guide/index.html 

or downloaded using http://rsb.info.nih.gov/ij/docs/guide/user-guide.pdf.  

This protocol was based on the video tutorial found at 

http://imagejdocu.tudor.lu/doku.php?id=video:analysis:gel_quantification_analysis 

All video tutorials can be accessed at http://imagejdocu.tudor.lu/doku.php?id=video:start 
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